Smears and Recall User Guide
Copyright Notice
© 2014 INPS
All Rights Reserved.

No part of this document may be photocopied, reproduced, stored in a retrieval system or transmitted in any form or by any means, whether electronic, mechanical, or otherwise, without the prior written permission of INPS.

No warranty of accuracy is given concerning the contents of the information contained in this publication. To the extent permitted by law, no liability (including liability to any person by reason of negligence) will be accepted by INPS, its subsidiaries or employees for any direct or indirect loss or damage caused by omissions from or inaccuracies in this document.

INPS reserves the right to change without notice the contents of this publication and the software to which it relates.

Product and company names herein may be the trademarks of their respective owners.

INPS Ltd.
The Bread Factory
1a Broughton Street
London
SW8 3QJ
Website: www.inps.co.uk
# Contents

## SMEARS AND RECALL

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>How to add a Recall</td>
<td>5</td>
</tr>
<tr>
<td><strong>Add a New Cervical Smear (Smear Taken)</strong></td>
<td>6</td>
</tr>
<tr>
<td>First record that the smear has been taken</td>
<td>6</td>
</tr>
<tr>
<td>Update an Existing Smear Result when result arrives</td>
<td>7</td>
</tr>
<tr>
<td>Select the Right Read Codes For Smear Result</td>
<td>10</td>
</tr>
<tr>
<td>Codes to trigger recalls</td>
<td>11</td>
</tr>
<tr>
<td>Exclude a patient, eg with hysterectomy, from cervical cytology target figures</td>
<td>11</td>
</tr>
<tr>
<td>How to run the Cervical Cytology Recall</td>
<td>13</td>
</tr>
<tr>
<td>What you are trying to achieve</td>
<td>13</td>
</tr>
<tr>
<td>The steps</td>
<td>13</td>
</tr>
<tr>
<td>The monthly searches</td>
<td>14</td>
</tr>
<tr>
<td>Generate recall letters</td>
<td>14</td>
</tr>
<tr>
<td><strong>Building the Cytology Searches</strong></td>
<td>15</td>
</tr>
<tr>
<td>Finding Cytology results with NO cytology recall in last 5y</td>
<td>15</td>
</tr>
<tr>
<td>Finding Hysterectomies in a Medical History</td>
<td>16</td>
</tr>
<tr>
<td>Search 1 - Automatically exclude those who have just had a cytology performed and are awaiting the result</td>
<td>17</td>
</tr>
<tr>
<td>Search 2 - Search for the last cytology recall (Set up Date) in a patient’s record looking back 5 years and forward 1 month, excluding hysterectomies</td>
<td>18</td>
</tr>
<tr>
<td>Search 3 - Find patients who are pregnant, have a referral for colposcopy, and last smear test was either inadequate or not sexually active</td>
<td>19</td>
</tr>
<tr>
<td>Search 4 - Find patients who have no cytology entry ever - they also need a 1st invite letter</td>
<td>20</td>
</tr>
<tr>
<td>Search 5 - Last Cytology result &quot;Inadequate&quot; – 1st recall</td>
<td>21</td>
</tr>
<tr>
<td>Search 6 - Last Cytology result &quot;Inadequate&quot; - 2nd recall</td>
<td>22</td>
</tr>
<tr>
<td>Search 7 - Last Cytology result &quot;Inadequate&quot; – 3rd recall</td>
<td>22</td>
</tr>
<tr>
<td>Search 8 - Last Cytology result &quot;Inadequate&quot; – Screen not wanted</td>
<td>23</td>
</tr>
<tr>
<td>Batching the searches</td>
<td>24</td>
</tr>
<tr>
<td><strong>Running the Monthly Cervical Cytology Recall Search Procedure</strong></td>
<td>24</td>
</tr>
<tr>
<td>Quick recap</td>
<td>25</td>
</tr>
<tr>
<td>Filtering out Clinical Audits from Patient groups</td>
<td>25</td>
</tr>
<tr>
<td>Sending out 1st Cytology Letter</td>
<td>26</td>
</tr>
<tr>
<td>Sending out 2nd Cytology Letter</td>
<td>32</td>
</tr>
<tr>
<td>Sending out 3rd Cytology Letter</td>
<td>37</td>
</tr>
<tr>
<td>After 3 Cytology invites enter – Ca cervix screen – not wanted</td>
<td>38</td>
</tr>
</tbody>
</table>

## Recalling patients with inadequate smears

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending out 1st recall for Inadequate Cytology</td>
<td>42</td>
</tr>
<tr>
<td>Sending out 2nd &amp; 3rd recalls for Inadequate Cytology</td>
<td>45</td>
</tr>
</tbody>
</table>
After 3 invites for inadequate result enter Ca cervix screen – not wanted 45

Cervical Cytology Recall Search 49
Some points about the Cytology Recall Search 49
Run the Cytology Recall Search 49
Find patients with specific smear results such as severe dysplasia 52

Cervical Cytology - groups from Clinical Audit 54

Review the Groups in Patient Groups 55
Review the group 55
Combine or exclude patients within groups 56
Print labels for the recall letters 57
Printing Patient Address Labels in Microsoft Word 58
Print out a list of patients sent a letter 67
Emails and Vision for flu clinics 68

How do I create template letters for recall? 69
First choose which Word Processor 70
Set up recall templates in Word or Vision Editor 71

INDEX 79
Smears and Recall

Introduction

Taking the cervical cytology recall procedure as an example, this guide explains:

- Making a data entry with a recall
- For smear entries, specifically making the entries needed for a cytology recall system
- Searching for patients needing a recall letter, excluding those who do not
- Generating recall letters to the patients
- How to maintain a recall process as a monthly routine
- Setting up template recall letters

How to add a Recall

1. There are various ways of adding a recall:
   - On a data entry screen in Consultation Manager, click on ☐ or ☒ Recal and enter a recall date and suitable Read code. This icon is found on most Add screens and can apply to other categories such as blood pressure, medical history etc.
   - From Patient Records, use the drag and drop facility - click on an entry for which the recall is to be made, and holding the mouse button down to display the floating drop target, drag the entry towards this and drop it on the Recalls icon - this has the advantage of entering the problem in the Read Term for Recall.
   - Right click on the Recalls line on the navigation line, and select Add.

2. The recalls can be searched from Search & Reports creating a group of patients to be recalled.

3. This group of patients can be merged with a suitable template recall letter, printing the letters and if required, address labels.
4. A record can be written back to Consultation Manager to record that a recall letter has been sent.

Add a New Cervical Smear (Smear Taken)

The rationale is that you make a cervical smear entry the day that the smear is taken. Later, when the result is through, you can update this entry with the laboratory result. This way you can track smears, making sure all the results have come through.

First record that the smear has been taken

1. In Consultation Manager, select the patient or press <F3>.
   Make sure a consultation is started – if not, click on icon or press <F7>. Note that this step is superfluous if the consultation is started automatically when the patient is selected.

2. Click on the Add menu and select Cytology, or press <ALT> A Y.

3. At the Cervical Cytology – Add screen, just press OK or press <CTRL + K> UNLESS you want to change the Date Smear Performed (defaults to today’s date).
Usually all the defaults can be accepted as displayed. **For this first smear entry, do not enter a recall record at this stage, or change the Read term.** 6859 Ca cervix - screen done is an acceptable code for QOF reports under the nGMS Contract.

**A note about the Target Report -** If the patient is eligible by age for the target report, and the smear is adequate, it will automatically be counted towards the practice target figures.

**Update an Existing Smear Result when result arrives**

1. Click on the icon or press <F3> and select the required patient.
2. Click on the List menu and select Cytology; or press <ALT> L Y;
3. The Cervical Cytology – List screen, similar to the following, is displayed:

```plaintext
<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>26/04/05</td>
<td>Ca cervix - screen done</td>
</tr>
<tr>
<td>26/04/02</td>
<td>Cervical smear result</td>
</tr>
<tr>
<td>21/03/99</td>
<td>Cervical smear: negative</td>
</tr>
<tr>
<td>27/07/94</td>
<td>Cervical smear: negative</td>
</tr>
<tr>
<td>19/12/91</td>
<td>Cervical smear: negative</td>
</tr>
<tr>
<td>06/09/90</td>
<td>Cervical smear: negative</td>
</tr>
<tr>
<td>37/06/89</td>
<td>Ca cervix - screen done</td>
</tr>
<tr>
<td>18/01/81</td>
<td>Cervical smear: negative</td>
</tr>
</tbody>
</table>
```

List-Cytology
4. The topmost entry on a list - Ca cervix - screen done - will usually be the one to be updated. Right click on this line and select **Edit**.

5. Click in the **Read Term for Result** field and click on the appropriate result from the displayed picklist. Make sure that your result code is a four-digit code starting with 4K2 for cervical smears and 4KA for vault smears. This will ensure that searches are reliable and accurate, and that the QOF reports pick up valid codes. The section on "Select the Right Read Codes For Smear Result (page 10)" has a list of the available Read codes and explains their best use.

6. If required, click in the **Inflammation Category** field and click on the appropriate entry from the displayed list.

7. In **Date Smear Reported**, enter the test date. You can use the abbreviated date format, T and press Enter for today's date, or –1D for yesterday, -3D three days ago and so on.
8. The recall date is not generated automatically, so click on or to record this. The Recall – Add screen is displayed:

9. Change the date in Set Up Date to today’s date, by typing T and press Tab until you reach the Recall Date.

10. In Recall Date, type in the recall interval time period as required - 1y, 3y, 5y, 6m.

   Note - that if you enter the date in the 3y or 6m format, the actual date will only be displayed when you move to the next field or when you click on the button.

11. Read Term for Recall Trigger defaults to whatever the Read term result is on the front Cervical Cytology Add screen. Read Term for Recall Reason defaults to the same Read code.

   Note that only the following codes trigger recalls on the Cervical Cytology Recall Search:

   - 4K2.. Cervical smear result
   - 4KA.. Vaginal vault smear result
   - 685.. Cervical neoplasia screen (or cervical cytology screen)
   - 4K4.. Cervical smear - action needed
   - 908.. (note - this is O not zero) - Cervical smear screen admin
   - K55.. Noninflammatory cervical disorders
   - B831. Carcinoma in situ of cervix uteri

12. Click to complete the recall. On the Cytology Add screen again, the Recall icon will be ticked.
13. Click on the **OK** button to accept the amended cytology record.

This should now appear as the latest cervical cytology entry on the list.

<table>
<thead>
<tr>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>26/04/05</td>
<td>Cervical smear normal Reported 26/05/05 Recall due: 26/05/08</td>
</tr>
<tr>
<td>26/04/02</td>
<td>Cervical smear negative Recall due: 26/04/05</td>
</tr>
<tr>
<td>21/03/99</td>
<td>Cervical smear negative Recall due: 20/03/2002</td>
</tr>
<tr>
<td>19/12/91</td>
<td>Cervical smear negative Recall due: 18/12/1994</td>
</tr>
<tr>
<td>06/09/90</td>
<td>Cervical smear negative Recall due: 05/09/1993</td>
</tr>
<tr>
<td>07/06/89</td>
<td>Cervix - screen done Recall due: 07/09/1989</td>
</tr>
<tr>
<td>10/01/84</td>
<td>Cervical smear negative Recall due: 10/01/1984</td>
</tr>
</tbody>
</table>

**Select the Right Read Codes For Smear Result**

It is very important to be consistent with Read terms when entering cervical cytology results. This ensures that smear searches result in accurate and complete reports.

There are many possible ways of coding results and recalls, and you should spend some time deciding on a possible coding methodology. Once a method has been decided, it may be advisable to produce a protocol to ensure that the appropriate codes are used at all times.

Note that only 4K2.., 4KA.. and 685.. hierarchies are available for coding cervical cytology results - the other hierarchies can be used on recording general history or recall entries:
Codes to trigger recalls

Note that only the following codes trigger recalls on the Cervical Cytology Recall Search:

1. 4K2.. Cervical smear result
2. 4KA.. Vaginal vault smear result
3. 685.. Cervical neoplasia screen (or cervical cytology screen)
4. 4K4.. Cervical smear - action needed
5. 908.. (note - this is O not zero) - Cervical smear screen admin
6. K55.. Noninflammatory cervical disorders
7. B831. Carcinoma in situ of cervix uteri

Exclude a patient, eg with hysterectomy, from cervical cytology target figures

The Target Report can be run from the Vision - Searches & Reports. You can exclude a patient from the Cervical Cytology Target Report if:

- they have had a **hysterectomy**,  
- smear follow-ups have been stopped,  
- or you consider it **inappropriate** to carry out a smear,  
- or the patient has **refused** to have a smear.

Note that always the latest cytology record must have Exclude from Target Report selected (ticked) for the patient to be excluded from the Target Report. This means that if you enter a new smear result for this patient with a later date, you must remember to tick the Exclude box again.

1. Select the patient and start a consultation.
2. Select **Add – Cytology**.
3. On the Cervical Cytology – Add screen, click on **Exclude from Target Report** so that it is selected (checked).
4. Select a **Reason for Exclusion**: Hysterectomy, Follow-up stopped, Patient refusal, or Considered inappropriate.
5. Select an appropriate Read code:
6. These four codes will exclude the patient from Cervical Cytology Recall, but so will ticking the Exclude from Target Report box and selecting a suitable reason:
   - 685G No smear - not sexually active
   - 685H No smear - benign hysterectomy
   - 6853 No smear - not wanted
   - 6855 No smear - not needed.
7. **Refused or not wanted**
   - 685L Cervical smear refused
6853 Ca cervix screen - not wanted

8. Hysterectomy codes

- 685H. No smear- benign hysterectomy
- 685H.11 No smear - hysterectomy
- 685I. No smear-amputation of cervix
- 685K. No smear - no cervix
- 7E040 Abdominal hysterocolpectomy and excision periuterine tissue
- 7E042 Abdominal hysterocolpectomy NEC
- 7E043 Total abdominal hysterectomy NEC
- 7E046 Radical hysterectomy
- 7E049 TAH - Tot abdom hysterectomy and BSO - bilat salpingophorect
- 7E05. Vaginal excision of uterus
- 7E05.11 Schauta radical vaginal hysterectomy
- 7E05.12 Vaginal hysterectomy
- 7E050 Vaginal hysterocolpectomy and excision of periuterine tissue
- 7E051 Vaginal hysterectomy and excision of periuterine tissue NEC
- 7E052 Vaginal hysterocolpectomy NEC
- 7E053 Vaginal hysterectomy NEC
- 7E053.11 Heaney vaginal hysterectomy
- 7E054 Laparoscopic vaginal hysterectomy
- 7E05y Other specified vaginal excision of uterus
- 7E05y.11 Ward vaginal hysterectomy
- 7E05z Vaginal excision of uterus NOS

9. Click OK.
How to run the Cervical Cytology Recall

What you are trying to achieve

These step-by-step instructions for running a Cervical Cytology Recall programme are designed as a general guide. We recognise that each practice has a particular protocol for this recall programme and may not use the same procedures as those outlined below. Despite these differences, however, the instructions should be helpful, even if only as a starting point for a practice-specific protocol.

Once you have set the searches and batched them in Search & Reports, you can schedule to run every month. There are six groups to whom letters may be sent: 1st invite for smear, 2nd invite, 3rd invite. 1st invite because smear was inadequate, 2nd inadequate smear recall, 3rd inadequate smear recall. Once patients have had three invitations, they can then be counted as 6853 Ca cervix screen - not wanted, which excepts them from QOF reports.

A basic knowledge of Search & Reports is assumed for this section.

The instructions are based on the following protocol:

1. Female patients between the ages of 25 to 64 are invited for cervical cytology screening.
2. Any patients who have not responded to the first letter receive a second letter three months after the first one.
3. Any patients who have not responded to the second letter will receive a third letter three months after the second one.
4. Non-responders to the third letter are given a recall entry of Cervical Smear Defaulter with a recall date in three years time. They will then go back into the normal cycle of three letters.

Note - that this protocol does not include patients who have never had a smear. A separate search needs to be carried out for these patients - see Finding Cytology results with NO cytology recall in last 5y (page 15).

The steps

Start with two preliminary searches:

(i) to find patients that do have a cytology record but do not have a recall. All cytology results must have a recall setup. The search does not search the cytology result, only the recall. Edit each patient's record and add a recall.

(ii) Run a search to find patients with hysterectomy entered on Medical History only. For each patient, add a Cytology record with Hysterectomy as Reason for Exclusion.
**The monthly searches**

The searches can be set up and batched in Searches and Reports and can then be run every month, without the need to alter the criteria.

1. Run the search of 25-64 year old females to exclude automatically those who have just had a cytology performed in the last 6 weeks and are awaiting the result.

2. Run the cytology recall search to find the last cytology recall (Set up Date) in a patient’s record, looking back 5 years and forward 1 month, excluding cytology target report hysterectomies. If;
   - Last cytology "Recall Date" is overdue; they require a 1st invite letter of #9085 "Cervical smear – 1st recall", with recall deferred for 2 months.
   - Last recall is #9085 "Cervical smear – 1st recall", they require a 2nd invite, with recall deferred for 2 months
   - Last recall is #9086 "Cervical smear – 2nd recall", they require a 3rd invite, with recall deferred for 2 months
   - Last recall is #9087 "Cervical smear – 3rd recall", they require a recall only, (no letter) deferred for a year of #6853 Ca cervix screen – not wanted

1. Run search to find patients who are pregnant, have a referral for colposcopy, and last smear test was either inadequate or not sexually active; the latter is optional, for exclusion this time round from receiving a cytology invite.

2. Run search to find patients who have no cytology entry whatsoever; they will also require a 1st invite letter. This should consist of mainly females turning 25 years old, as long as patient notes have been summarised within 8 weeks (i.e. Search 1).

3. Run searches to find last cytology result that is inadequate, send out relevant recall letters, after 3 recall letters have been sent the recall is deferred for a year and a Read code of #6853 Ca cervix screen – not wanted is entered.

4. Refer to *Quick recap* (page 25).

**Generate recall letters**

1. In Patient Groups, filter out patients (see page ) by combining groups in step 2 & 4, and then exclude patients in Search 3 (exclusions) this time round, then send out each relevant invite letter.
   - Send 1st cytology recall letter - see page
   - Send 2nd cytology recall letter - see page
   - Send 3rd cytology recall letter - see page
   - Record a 6853 Ca cervix screen - not wanted for non-responders - see page
   - Send 1st recall letter for inadequate smear - see page
   - Send 2nd recall letter for inadequate smear - see page
   - Send 3rd recall letter for inadequate smear - see page
   - Record a 6853 Ca cervix screen - not wanted for non-responders - see page

2. Run this same process every month.
Building the Cytology Searches

Do two preliminary searches (i) to find patients that do have a cytology record but do not have a recall. All cytology results must have a recall setup. The search does not search the cytology result, only the recall. Edit each record and add a recall. (ii) Run a search to find patients with hysterectomy entered on Medical History only. For each patient, add a Cytology record with Hysterectomy as Reason for Exclusion.

Finding Cytology results with NO cytology recall in last 5y

For the cytology recall search to work correctly, every cytology result must have a recall set in the last 5y
For each person found in the search, open Consultation Manager, List Cytology, right mouse click and edit the last cytology entry, adding a recall by clicking on and type in the correct Recall Date.

Finding Hysterectomies in a Medical History

This section looks for hysterectomies which have been recorded in Medical History but not in Cervical Cytology Add. It is important to record hysterectomies in Cytology in order to include a Reason for Exclusion - Hysterectomy.

The search above is looking for hysterectomy NOT recorded in the target report within the Cytology entity and/or has no reason recorded. If the search reveals patients, make sure each of the patients found in the search has a Cervical Cytology - Add entry:

- Change the date to that of the hysterectomy found in the medical history
- Use a relevant Read code such as 685H.11 No smear - hysterectomy
• Select Hysterectomy in Reason for Exclusion, as detailed above. Do NOT delete the medical history hysterectomy entry, as it is not wrong. The cervical cytology search procedure simply uses the target report as an exclusion, not medical history.

Search 1 - Automatically exclude those who have just had a cytology performed and are awaiting the result

Build the search as above. Note:

1. Cervical Cytology entity is **Exclude** – right mouse click > Options

2. Double click **Group Output** and save the patient group. (i.e. CXFEMALES)

3. Date patient accepted by agency = Before **T-8w** (this is to give you time to summarise the patient notes, i.e. the patients are not included for 8 weeks)

4. **Save** the search (i.e. CX - Active Female Cytology Patients 25y-64y)

5. **Run** the search and Close
Search 2 - Search for the last cytology recall (Set up Date) in a patient's record looking back 5 years and forward 1 month, excluding hysterectomies

1. Click on the Cervical Cytology Recall Search button
2. Build the search as displayed below;
3. Choose your Input Group - **CXFEMALES**

4. Rename all the Output Group Names and tick to **Replace**
5. **Save** the Search (Cervical Cytology Recall Search)
6. Click **Search** button.

Further details of the Cervical Cytology Recall Search are given in *Some points about the Cytology Recall Search* (page 49) and *Run the Cytology Recall Search* (page 49).
Search 3 - Find patients who are pregnant, have a referral for colposcopy, and last smear test was either inadequate or not sexually active

Build the search as above. Note:

- Group Input = **CXFEMALES** (double click and select the group)
- Group Output = **CXEXCLUDES** (double click and name the group)
- Cervical Cytology (latest 1 before match) = right mouse click on Cytology entity in the right window, click Options, select Before match.
- Match Any
- Report Details - Cervical Cytology entity "Latest 1 before match" – right mouse click > Options (click in Before Match; Latest = 1) - illustrated on next page
- Save the search
- Run the search
The last inadequate result will be picked up later in a separate search so that a different letter may be sent out. This is why it is being excluded now - this way the patient will not receive two different letters.

Search 4 - Find patients who have no cytology entry ever - they also need a 1st invite letter

Build the search as above. Note:

- Cervical Cytology entity is **Exclude** - right mouse click > Options

- Double click **Group Output** and save the patient group. (i.e. CXNOSMPEAR Cytology - 1st Letter required (No CX Ever))

- **Save** the search

- **Run** the search and close
Search 5 - Last Cytology result "Inadequate" – 1st recall

Build the search as above. Note:

- Cervical Cytology entity "Latest 1 before match" – right mouse click > Options;
- Double click **Group Output** and save the patient group. (CXINADLET1);
- **Save** the search.
- **Run** the search and then close.
Search 6 - Last Cytology result "Inadequate" - 2nd recall

Build the search as above. Note:

- Recall – Date for recall
- Recall #2 – Date recall entered, entity is Exclude – right mouse click > Options
- Cervical Cytology - Latest 1 before match
- Double click Group Output and save patient group. (i.e. CXINADLET2)
- Save the search.
- Run the search and then close

Search 7 - Last Cytology result "Inadequate" – 3rd recall

Build the search as above. Note:

- Recall – Date for recall
- Recall #2 – Date recall entered, entity is Exclude – right mouse click > Options
- Cervical Cytology - Latest 1 before match
- Double click Group Output and save patient group. (i.e. CXINADLET3)
- Save the search.
- Run the search and then close
Search 8 - Last Cytology result "Inadequate" – Screen not wanted

Build the search as above, note:

- Recall – Date for recall
- All other clinical data entity is Exclude – right mouse click > Options
- Cervical Cytology - Latest 1 before match
- Double click Group Output and save patient group. (i.e. CXINADSNW)
- Save the search.
- Run the search and then close
Batching the searches

Now all the searches have been built, create a batch folder in which to store them.

1. Press F7 or click on the Reports menu in Search & Reports and select **New Batch**.
2. Name the new batch folder.

3. Now drag each cytology search **onto** the folder as below, in the correct order.

   ![New Batch Dialog](image)

   *Note* - The order is important, "CX – Active Female Cytology Patients 25y-64y" **must** be run first.

You can now proceed to run the cervical cytology recall searches laid out below.
The next section is your ongoing monthly task.

---

**Running the Monthly Cervical Cytology Recall Search Procedure**

Every month:

1. Drag the yellow folder Cervical Cytology Recall Search into the Schedule.
2. Click the clock picture button or press F5 on your keyboard.
3. Click the GO button.

This will run the entire batch of searches one after the other.

Alternatively, if you prefer to run them one at a time, open each search in the order laid out in the yellow folder and run each search to repopulate patient groups.
Quick recap

These searches will now:

- Find all 25y > 64y female active patients and exclude those, registered in the last 8 weeks (to give you time to summarise the patient notes), who have just had a cytology performed in the last 6 weeks and are awaiting the result.
- Search for the last cytology recall in a patient’s record looking back 5 years and forward 1 month, excluding hysterectomies from the target report. This will create 4 letter groups and 1 hysterectomy group.
- Find patients who are pregnant, have a referral for colposcopy, and last smear test was either inadequate or not sexually active, the latter being optional.
- Find patients who have no cytology entry whatsoever.
- Find the last cytology result which is inadequate, for separate recall letter
- Find patients whose cytology result has NO recall.

Filtering out Clinical Audits from Patient groups

1. Open Patient Groups and maximise both windows.
2. Click on the Browse Options menu and select "Set Filter".
3. From the Select Group Category click the User option.
4. Click OK (this will filter out all the clinical audits and only display staff user patient groups)
5. When you have finished sending out all the recall letters, you may wish to clear the filter.
Sending out 1st Cytology Letter

Scroll down the Name column to locate all the CX group names

1. Highlight CXLET1 and click the Blue dot "Make selected group the workgroup"

2. Now highlight CXNOSMEAR and click the last of the option buttons  Add patients in the selected group to the workgroup. This combines both groups as they both require a first letter.

3. Now highlight the CXEXCLUDES group
4. Click the 4th option – **Remove patients in the selected group from the workgroup.** This will remove patients that are currently pregnant, have a referral for colposcopy, and last smear test was either inadequate or not sexually active from the current workgroup.
5. Click the Group Applications menu > **Generate Recalls** > for the Workgroup

6. Click on the upper **Create** button (Add Recall to Medical History). This will enter a Recall into the patients' records.

7. Enter a **Recall Date** interval, (to give the patient time to book the cytology) until the next recall letter is generated, eg. 2 months.

8. Enter the exact **Read Term for Recall Trigger** as shown above #9085 Cervical smear - 1st recall.  **No other Read code can be used.** (The O in the Read code is a capital, NOT a zero.)

9. Click **OK**

10. Click the lower **Create** button (Personalised Letters).  This is where you may choose the cervical cytology 1st invite letter.
11. Click on **Browse** and double click on the correct 1st invite letter from the directory `\vision\data\wordproc\template`. Click on OK. (These letters are pre-prepared - see *How do I create template letters for recall?* (page 69)).

12. Click the **View** button to open the letter.

13. Highlight the body of the letter, then click on the **Edit** menu and select **Copy**.

14. Close Microsoft Word – **File > Exit**.

15. Say **No** to saving changes.

16. Click **OK**.

17. Double check that all the details are correct and that the printer is loaded with sufficient paper to print all letters – the total number required can be seen in the bottom section of the Group Recalls screen (**Number of patients in group**).

18. You can limit the print run, for example, if there are 50 patients in your group, you can enter a smaller number in **Limit Processing To**. If 0 (zero) is shown in **Limit Processing To**, this is all patients in the group. Note that you cannot restart though at the next number.
19. Click the **Start** button. This will print all the letters and enter a recall into all the patients' records of Cervical Cytology - 1st recall. A window is displayed which shows the progress of the process - creating the merged file, retrieving the merged details, printing the letters.

![Group Recalls](image)

20. When complete, the message **All letters have been printed** is displayed. Click on **Close**, which exits from Group Recalls.

21. Click Group Applications menu > **Generate History** > for the Workgroup.

![Patient Groups](image)
22. Enter the Read code **#9085 Cervical smear - 1st recall**. Click into the Comment text box and paste the contents of the letter using the keyboard keys Ctrl+V, change the priority number to 9 (or another number if 9 is being used by your practice for something else).

23. Click **OK** (This will enter the actually cytology letter you sent into the patients’ Journal).

24. To print address labels, see *Print labels for the recall letters* (page 57) on page 57.

**Note** - If this was the first time you have used this monthly cervical cytology recall search, the remaining CXLET2, CXLET3 & CXLET4 groups will be empty. Therefore you may need to skip to the section on *Sending out 1st recall for Inadequate Cytology* (page 42) on page 42 to generate invite letters for these patients.

Run this search program each month. On the second month (because in the example we set the interval date at two months) CXLET2 may have patients, if they have not had a cytology recorded within the two month period. After a further two months, CXLET3 may have patients etc...

The last group CXLET4 will receive the Read code of **#6853 Ca cervix screen - not wanted with a recall interval of 1y**, which defers the recall for a year and satisfies QMAS as a cytology exception.

The following CXLET2, 3, & 4 invites are explained below.
Sending out 2nd Cytology Letter

1. If you have just run CXLET1, Click the White dot button "Clear the workgroup".

2. Highlight CXLET2 and click the Blue dot "Make selected group the workgroup"

3. Now highlight the CXEXCLUDES group.
4. Click the 4th option  Remove patients in the selected group from the workgroup.
   This will remove patients who are pregnant, have a referral for colposcopy, and last smear test was either inadequate or not sexually active.
5. Click the Group Applications menu > Generate Recalls > for the Workgroup
6. Click on the first **Create** button (Add Recall to Medical History). This will enter a Recall into the patients record.

![Group Recalls](image1)

7. Enter a **Recall Date** interval, (to give the patient time to book the cytology) until the next recall letter is generated i.e. 2 months

![Recall](image2)

8. Enter the exact **Read Term for Recall Trigger** as shown above #9086 Cervical smear - 2nd recall. **No other Read code can be used.** (The O in the Read code is a capital, NOT a zero.)

9. Click **OK**

10. Click the second **Create** button (Personalised Letters); this is where you choose the cervical cytology 2nd invite letter.
11. Click the **Browse** button and double click on the correct 2nd invite letter or click the Open button.

![Select Recall Template to Open](image)

12. Click the **View** button to open the letter.
13. Highlight the body of the letter and click on the Edit menu and select Copy.
14. Close Microsoft Word – **File > Exit**.
15. Say **No** to Do you Want to Save the Changes.
16. Click **OK**.
17. Click the **Start** button. This will print all the letters and enter a recall into all the patients records of Cervical smear – 2nd recall.
18. When complete click Group Applications menu > **Generate History** > for the Workgroup

19. Enter the Read code **#9086 Cervical smear - 2nd recall** as used in the recall. Click into the Comment text box and paste the contents of the letter using the keyboard keys Ctrl+V, change the priority number to 9 (or another number if 9 is being used by your practice for something else)

20. Click **OK** (This will enter the actually cytology letter you sent into the patients’ Journal)
21. To print address labels, see *Print labels for the recall letters* (page 57) on page.

**Note** - If this was the first time you have used CXLET2 cervical cytology recall search, the remaining, CXLET3 & CXLET4 groups will be empty. Run this search program each month, in a further two months time (because in our example we set the interval date at 2m) CXLET3 may have patients, if they have not had a cytology recorded within the 2m period. After a further 2 months CXLET4 may have patients.

**Sending out 3rd Cytology Letter**

Repeat the same process as laid out in CXLET2 for CXLET3 (3rd Cytology Letter). Instead of Read code #9086 (2nd recall), use **#9087 Cervical smear - 3rd recall**, and use 3rd cytology letter.

1. If you have just run CXLET2, Click the White dot button "Clear the workgroup"

2. Highlight CXLET3 and click the Blue dot **Make selected group the workgroup**

3. Now highlight the CXEXCLUDES group.

   Click the 4th option **Remove patients in the selected group from the workgroup**. This will remove patients who are pregnant, have a referral for colposcopy, and last smear test was either inadequate or not sexually active.

4. Click the Group Applications menu > Generate Recalls > for the Workgroup
5. Click on the first **Create** button (Add Recall to Medical History). This will enter a Recall into the patient's record.

6. Enter a **Recall Date** interval, (to give the patient time to book the cytology) until the next recall letter is generated i.e. 2 months.

7. Enter the exact **Read Term for Recall Trigger** as shown above **#9087 Cervical smear - 3rd recall. No other Read code can be used**. (The O in the Read code is a capital, NOT a zero.)

8. Click **OK**.

9. Click the second **Create** button (Personalised Letters); this is where you choose the cervical cytology 3rd invite letter.

10. Click the **Browse** button and double click on the correct 3rd invite letter or click the **Open button**.

11. Click the **View** button to open the letter.

12. Highlight the body of the letter and click on the Edit menu and select **Copy**.

13. Close Microsoft Word – **File > Exit**.

14. Say **No** to Do you Want to Save the Changes.

15. Click **OK**.

16. Click the **Start** button. This will print all the letters and enter a recall into all the patients records of Cervical smear – 2nd recall.

17. When complete click Group Applications menu > **Generate History** > for the Workgroup.

18. Enter the **Read code #9087 Cervical smear - 3rd recall** as used in the recall. Click into the Comment text box and paste the contents of the letter using the keyboard keys **Ctrl+V**. Change the priority number to 9 (or another number if 9 is being used by your practice for something else).

19. Click OK (This will enter the actually cytology letter you sent into the patients' Journal).

20. To print address labels, see *Print labels for the recall letters* (page 57).

---

**After 3 Cytology invites enter – Ca cervix screen – not wanted**

If you have just run CXLET3, Click the White dot button "Clear the workgroup"

1. Highlight CXLET4
2. Click the Group Applications menu > Generate Recalls > for CXLET4

3. Click on the first **Create** button (Add Recall to Medical History). This will enter a Recall into the patients' records.
4. Enter a **Recall Date** interval of **1y** (this will defer the next invite for 1 year, whereby the process starts all over again with 1st cytology invite).

![Recall Date Interval](image)

5. Enter the Read code **Recall Trigger #6853 Ca cervix screen - not wanted**. This is the exception code used for QOF reporting.

6. Click **OK**.

7. You do **not** need to send a letter, only enter an updated recall.

8. Click the **Start** button; this will enter the Read code into the patients’ record, so that the cytology recall search can start again in a year’s time.

![Group Recalls](image)
9. When complete click Group Applications menu > Generate History > for CXLET4 (QMAS audits do NOT look in a recall, so you must enter #6853 as a History record for it to be picked up).

10. Enter the Read code #6853 as used in the recall, click into the Comment text box and type a reason for using the exception Read code (for audit purposes).

11. Change the Type of Characteristic to Administration.

12. You may also wish to change the priority to 2 so that it is filtered in the clinical summary.
13. Click **OK**.

## Recalling patients with inadequate smears

This section explains how to recall patients whose last cytology result was inadequate, and send out a recall letter, deferred for 2 months between each subsequent recall letter of up to a maximum of 3 letters per year, until the patient retakes the test.

### Sending out 1st recall for Inadequate Cytology

1. If you have just run CXLET4, Click the White dot button "Clear the workgroup"

2. Highlight CXINADLET1 group

3. Click the Group Applications menu > Generate Recalls > for **CXINADLET1**

4. Click on the first **Create** button (Add Recall to Medical History). This will enter a Recall into the patients record
5. Enter a **Recall Date** interval, (to give the patient time to book the cytology).

6. Enter Read code in **Recall Trigger** as shown above #9O8M Smear inadequate - 1st recall. (The O in the Read code is a capital, NOT a zero.)

7. Click **OK**.

8. Click the second **Create** button (Personalised Letters). This is where you choose the 1st cervical cytology inadequate letter.

9. Click the **Browse** button and double click on the correct invite letter or click the Open button.

10. Click **View** to open the letter

11. Highlight the body of the letter and click on the Edit menu and select **Copy**

12. Close Microsoft Word – **File > Exit**

13. Say **No** to saving changes

14. Click **OK**

15. Click the **Start** button. This will print all the letters and enter a recall into all the patients records
16. When complete, click **Group Applications** menu > **Generate History** > for CXINADLET1

17. Enter the Read code **#9O8M** as used in the recall, click into the Comment text box and paste the contents of the letter using the keyboard keys **Ctrl+V**, change the priority number to **9** (or another number if 9 is being used by your practice for something else)

18. Click **OK** (This will enter the actually cytology letter you sent into the patients’ Journal).
Sending out 2nd & 3rd recalls for Inadequate Cytology

If this was the first time you have used this monthly inadequate cervical cytology recall search, the remaining CXINADLET2, CXINADLET3 groups will be empty.

Run this search program each month, on the 2nd month (because in our example we set the interval date at 2m) CXINADLET2 may have patients, if they have not had a cytology re-recorded within the 2m period. After a further 2 months CXINADLET3 may have patients.

Repeat the same process as laid out in CXINADLET1 for CXINADLET2 & 3. Exchanging Read code from #908M to:

- #908N, and use the 2nd inadequate cytology letter
- #908O, and use the 3rd inadequate cytology letter

Finally if a cytology result has not been recorded after the 3 invites, continue to the next section…

After 3 invites for inadequate result enter Ca cervix screen – not wanted

1. If you have just run CXINADLET3, Click the White dot button "Clear the workgroup"
2. Highlight **CXINADSNW**.

3. Click the **Group Applications** menu > **Generate Recalls** > for **CXINADSNW**

4. Click on the first **Create** button (Add Recall to Medical History). This will enter a Recall into the patients’ records.
5. Enter a "Recall Date" interval of **1y** (this will defer the next invite for 1 year, whereby the process starts all over again with 1st cytology invite)

6. Enter the Read code **Recall Trigger #6853 Ca cervix screen - not wanted**; this is the exception code used for QOF reporting.

7. Click **OK**.

8. You do **not** need to send a letter, only enter an updated recall.

9. Click the **Start** button; this will enter the Read code into the patients’ record, so that the cytology recall search can start again in a year’s time.
10. When complete click **Group Applications - Generate History** for CXLET4 (QMAS audits do NOT look in a recall, so you must enter #6853 in a history for it to be picked up)

11. Enter the Read code #6853 as used in the recall, click into the Comment text box and type a reason for using the exception Read code (for audit purposes)

12. Change the Type of Characteristic to **Administration**

13. You may also wish to change the priority to 2 so that it is filtered in the clinical summary.
Cervical Cytology Recall Search

On page , you looked briefly at running the Cervical Cytology Recall Search as part of the routine monthly cytology recall procedure. This section explains this in more detail.

Some points about the Cytology Recall Search

- The Cytology Recall Search option is specifically designed to find patients whose recall for a cervical smear is due. Once the group has been saved and given a name, and the search has been run, you may then use the group to generate recall letters in the Patient Groups and Recalls module.

- The Cytology Recall Search finds patients whose most recent smear recall date falls within the date range of the search (by default this is between five years ago, and one month ahead). There must be a triggering Read code entered in Recall Trigger on Recalls. These Read codes are pre-defined but you can change them if you like.

- The most recent recall is the one with the latest EVENT date. So this search looks for the patient's latest cervical smear result and the recall date attached to it, eg Last smear result 1.1.01, with a 3 year recall due in January 2004.

- All ineligible patients are then removed (excluded) from this group and placed in one of four separate groups (see step 3) - hysterectomy, refusal, not needed, inappropriate.

- If you have previously entered the correct Read codes in Read Term for Trigger/Recall (see step 15 of the section Review the Groups in Patient Groups (page 55)), the remaining eligible patients are then placed in one of four groups depending on whether they require the first, second, third or fourth smear recall letter. Group names are automatically given to each group.

Run the Cytology Recall Search

Select Search & Reports from the Vision Reporting front menu.

1. To display the Cervical Cytology Recall Search screen:

   - Either click on , or select Reports - New Cervical Cytology Recall Search; or click on the green heading Cervical Cytology Recall Searches
to expand the list of any previously run searches, then click on , or point to this and click with the right mouse and select View Search.

**Note** - the date that this search was last run is shown in the list under the green heading Cervical Cytology Recall Searches.

2. **Input Group** - This defaults to **All Active** and **applied Females**. Select this if you have not done any pre-searches. If you have created earlier groups (as described on page where CXFEMALES was created), select **Group of patients** and select the group.

You may be able to accept the rest of the defaults without changing anything, and just click on **Search**. If so, skip to step 3. Otherwise, look at the illustration on the following page for an explanation of the fields and for our recommended procedure. On the keyboard, use the Tab key to move to the next entries.
3. Click on **Search**.
4. Once the search has been run, the five groups created in the search are displayed:

![Smear recall search](image)

5. Click **OK**.

6. Before exiting, you can **Save As** to save the search criteria and give it a name and description.

![Save Search](image)

7. When you next run the search, and if you have not changed any criteria, you can use the Save option to update the current search.

8. Click **Exit**.

Find patients with specific smear results such as severe dysplasia

The Cervical Cytology Recall Search only finds patients in the specific groups described (see page ).

Suppose you want to find all patients with, for example, positive smears of severe dysplasia, you will need to use an Ad-Hoc search in Search and Reports.

1. Click on **v**.

2. Specify females between 20 and 64:
   - Either first create a group from a search; call the group **20-64F**, then start a new search, double clicking in Group Input and selecting **20-64F**;
   - or select this criteria now by highlighting **Patient Details**, then click on **Selections**. Click on **Date of Birth**, then **Add New**. Click on **Range**
and enter dates which cover the age range, eg T-65y (EXC) and T-20y (INC). Click on Sex, then Add New, select Female. Click on OK.

3. Under Add Entity, double click on Clinical Data. Double click on Well Person Data, then click on Cervical Cytology, click on OK.

Highlight Cervical Cytology then Selections. Select Read code for smear, Add New, then type in one of the positive smear results codes, for example, 4K23 and Click Enter. (cervical smear - mild dysplasia) or 4K24 and Click Enter (cervical smear - mild or severe dysplasia) - for help on suitable codes, see Select the Right Read Codes For Smear Result (page 10). Note that if you choose 4K2..., and Hierarchical Search, this will include all smear results, including the negative and inadequate smears which you may not want. You could do a separate search for these.

If you like, specify other criteria as appropriate, eg Cervical inflammation, Source of Smear, Date smear reported, Exclude from Target report, Exclusion reason or Adequate smear. Finally, click OK.

4. If required, use Group Output to save the search result as a group.

5. Change the Report Output option to Standard or Summary if you want to print the report.

6. Click Run.

7. When the report is displayed on screen, click Print.
Cervical Cytology - groups from Clinical Audit

The Clinical Audit module will produce lists of patients who have had or are due cervical cytology, depending on the data entered in Consultation Manager. You may use these as the basis of recall letters if you prefer.

- Under In Practice Systems - Administration, Cytology Monitoring audits are written for practices in England to comply with Read codes acceptable under QOF Reporting. Note that Wales has a separate Cytology Monitoring in Wales audit.
• Under nGMS Contract QMAS Returns and Monitoring Audits - Additional Services, the Cytology QMAS Indicator audits show female patients (aged 25-64 in England, or 20-60 in Scotland) who are eligible for smears, or who have had a hysterectomy, or have refused cytology in the last 5 years, or who have not had a smear in the last 5 years.

Review the Groups in Patient Groups

Review the group

1. Select Patient Groups from the Vision Reporting menu. This displays all the user groups, by default, and excludes system groups, until Set Filter is changed.

2. Cervical smear recall groups begin with C. For example, C0110209 Requiring First Smear Recall Letter, C1110209 Requiring Second Smear Recall letter and so on.

3. Note that you can sort the columns by clicking on the column header, eg Date, Name.

4. To make a group into a workgroup, first highlight the group then click on the blue icon •. You can then save the work group with a new name.

5. To review a group, highlight it and then click on the View Groups (Open Folder) icon (second from the left).
- Double click on each name to show clinical details in the right-hand column.
- You can remove any patients by clicking on the **Remove Patient** icon (third from left).
- You can add a patient by clicking on Group - Add a new patient to Workgroup.
- If the group you are reviewing is not the workgroup, you can use the Group menu options to **Add Selected Patient to Workgroup**, or **Move Selected patient to Workgroup** (this removes it from the currently selected group).
- When all patients have been checked, click on the **Close** icon and save the changes made by answering Yes when asked to save.

Combine or exclude patients within groups

Combining groups, or excluding patients from groups is done from the Patient Groups module (Vision Reporting).

1. First find and select a group and make it into the **Work Group**.
2. Then select a second group and use one of the five icons, listed below, to process this with the Work Group. These options merge a secondary selected group with the Work Group with five different results.

   ![Icons](image)

   From left to right: Keep common patients, Remove common patients, Keep Patients that are not in work group, Remove patients from the workgroup, Add patients to the Workgroup.

3. Save the resulting Work Group with a new name.
4. Then select another group and process this with the saved Work Group, and so on.
Print labels for the recall letters

Labels addressed to individual patients within a group can be produced from Patient Groups. You can also generate labels for individual patients.

1. In Patient Groups, highlight the group for which you have printed letters; or if you want to print a label for an individual patient rather than a group, select this patient and make them into a Work Group. You can give this Work Group a name if you like. Then highlight the new Work Group.

2. Click on the icon for Print Patient Labels, or from Group Applications, select Print Labels.

3. Decide how many labels you want to print for each patient, the default is 1.
4. In Label Format, select the size of label for your printer:
   - Dot-Matrix - OML102 (10.16 x 3.65 cm)
   - Dot-Matrix - OML103 (10.16 x 4.92 cm)
   - Dot-Matrix - OML202
   - Dot-Matrix - OML203
   - Dot-Matrix - OML302
   - Dot-Matrix - OML303
   - Laser - L7164 (6.35 x 7.2 cm)
   - Laser - L7163 (9.9 x 3.81 cm)

   For example, Laser - L7163 (9.9 x 3.81 cm) are two column labels with 7 per column, and 14 per page.

5. If Do you wish to check label alignment is selected, this will give a preview of the labels after you click on Print in step 8.
6. Click on Print Options to select Printer.
7. Place the labels in the printer. You may prefer to use manual feed for a page of laser labels (face up).
8. Click on Print.
9. The name(s) of the patient(s) is displayed on screen. Click on the Print icon to proceed, then OK. Click Close.
Printing Patient Address Labels in Microsoft Word

1. In Vision - Patient Groups, select and highlight the group for which you require to print labels then click **Print Labels for Group**.

   ![Table of patient information]

   **Step 1 - Select Print Labels for Group**

2. Select **Print Options**.

   ![Print patient labels window]

   **Step 2**

3. Select Output Type to **File**.

   ![Reporting window]

   **Step 3**
4. Choose a location to save your address file and give it a suitable file name

Step 4

5. Select the Output Format as **Comma Separated Value**.
6. You are returned to the original window. Click **Print** and Vision will export the patient address details into the file you have named.

![Print patient labels dialog box]

**Step 6**

7. Open Microsoft Excel and open the file you have just created.

![Open file dialog box]

**Step 7**
8. You will be presented with a Text Import Wizard. Choose **Delimited** on Step 1. Click **Next**.

9. Choose **Comma** as the Delimiter on Step 2. Click **Next**.
10. This is an example of the Step 3 screen. Click **Finish**.

Step 10

11. Right mouse click on line 1 of the opened spreadsheet and select **Insert** from the dropdown menu.

12. This will provide you with a blank first row into which you should add the field titles, as suggested below.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Add_1</td>
<td>Add_2</td>
<td>Add_3</td>
<td>Location</td>
<td>Post Code</td>
</tr>
<tr>
<td>Ms Katherine Barker</td>
<td>31 Melbourne Road</td>
<td>32 Bushey Park Road</td>
<td>Hampton Wick</td>
<td>Teddi</td>
<td></td>
</tr>
<tr>
<td>Mr Colin Davies</td>
<td>Flat 2</td>
<td>47 Walden Road</td>
<td>Hampton Wick Kings</td>
<td>Teddi</td>
<td></td>
</tr>
<tr>
<td>Ms Erin Hughes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ms Patricia Jain</td>
<td>67 Holmsdale Road</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mr Kristian Hill</td>
<td>76 Hawkins Road</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Step 12

13. Save the document as a .txt file, over writing the original file you created from Vision. You can ignore any cautionary windows that warn about different file formats.
14. Open Microsoft Word and select **Mail Merge** from the **Tools** menu. You will be presented with the following window. Click the **Create** button under Main document.

![Mail Merge Helper]

**Step 14**

15. Click Active Window.

![Microsoft Word]

**Step 15**
16. Click the **Get Data** button under Data Source.

**Step 16**

17. At the Open Data Source screen, navigate to the location of the saved address file you have just modified in Excel and select **Open**.

**Step 17**
18. Click **Set Up Main Document** on the next window.

![Microsoft Word window](image)

**Step 18**

19. Choose the labels you intend to print on from the list provided. If your labels are not listed, you can define your own by clicking **New Label**.

![Label Options window](image)

**Step 19**

20. You will then be asked to insert your merge fields onto the label.
21. Click the *Merge* button to begin the merge process.

![Mail Merge Helper window](image)

**Step 21**

22. If the Merge window looks like the example below, click **Merge**.

![Merge window](image)

**Step 22**
23. The merge process will complete and present you with a page displaying the merged data in a Word document, as below. Select **Print** to produce your labels. If you wish, you could save the document for future use.

<table>
<thead>
<tr>
<th>Ms Katherine Barker</th>
<th>Mr Colin Davies</th>
</tr>
</thead>
<tbody>
<tr>
<td>31 Melbourne Road</td>
<td>32 Bushey Park Road</td>
</tr>
<tr>
<td>Teddington</td>
<td>Hampton Wick</td>
</tr>
<tr>
<td>Middx TW11 8BQ</td>
<td>Teddington</td>
</tr>
<tr>
<td></td>
<td>TW11 9EP</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ms Patricia Pain</th>
<th>Mr Kristian Hill</th>
</tr>
</thead>
<tbody>
<tr>
<td>67 Holmesdale Road</td>
<td>76 Hawkins Road</td>
</tr>
<tr>
<td>Hampton</td>
<td>Teddington</td>
</tr>
<tr>
<td>Middx TW11 9QX</td>
<td>Middx TW11 9HA</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mr Adrian Morgan</th>
<th>Ms Fanny Moss</th>
</tr>
</thead>
<tbody>
<tr>
<td>38 Fairways</td>
<td>88 Broom Road</td>
</tr>
<tr>
<td>Teddington</td>
<td>Teddington</td>
</tr>
<tr>
<td>Surrey KT1 4DL</td>
<td>Middx TW11 9HD</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mr Alfred Dalaya</th>
<th>Ms Juliet Lawless</th>
</tr>
</thead>
<tbody>
<tr>
<td>34 Coleshill Road</td>
<td>26 Conifers Close</td>
</tr>
<tr>
<td>Hampton Wick</td>
<td>Teddington</td>
</tr>
<tr>
<td>Kingston Upon Thames</td>
<td>Middx TW11 8AY</td>
</tr>
<tr>
<td>Middx TW11 8DA</td>
<td></td>
</tr>
</tbody>
</table>

Print out a list of patients sent a letter

You may want to print out a list of patients who are about to be sent, or have been sent, a recall letter.

1. You cannot print a list from Patient Groups so you need to go back into **Search & Reports (Vision Reporting menu)**.
2. Click on **✓**.
3. Double click in the **Group Input** window in **Search Input** and select the group.
4. On the Search screen, run the following report on the group:
   - Do not select anything in **Search Details**.
   - In Report Output, select Summary Report.
Click on the **Edit** menu and select **Report Output**. Enter a title suitable for the report. Double click on **Patient Surname** in the bottom left hand corner to display it in the right hand window. OK to close the screen.

Click on the **Run** button.

5. When the report is displayed on the screen, click on the **Print** button to print the report on the standard report printer.

---

**Emails and Vision for flu clinics**

If you are collecting patients’ email addresses and entering them in Registration - Addresses - Contacts for patients, you could use these to invite patients to flu clinics next year or indeed other recalls.

Create a group of patients for flu recall first:

Run a search on this group to find those with email addresses (Add Entity - Additional Patient Data - Communication Numbers, then Selections - Type of Number = E mail). Save the resulting group in Group Output, so you can deduct them (in Patient Groups) from the total flu recall group and be left with the ones you still have to send letters to.

Report Output - Export as a Tab Separated File. This creates a file in C:\extract called telephone.txt.

You can then use standard Microsoft Word Mail Merge to create email messages for the group with email addresses (this function is certainly available in Word 2002 upwards). You use the telephone.txt file you created earlier as your recipient source.
The email address is contained in the column headed NUMBER, which you select as your "To" field in the final step.

Note that the patient names are not available for a "Dear TITLE SURNAME" type heading.

How do I create template letters for recall?

First select whether Word or Vision Editor is the default word processor.

Next create the template letters for recalls or referrals, for instance, a first smear recall letter, second smear recall letter, referral letter, etc. If you are following the cytology recall procedure described earlier, you will need at least the following invitation letters to patients:

- Cytology 1st letter
- Cytology 2nd letter
- Cytology 3rd letter
- Cytology inadequate 1st letter
- Cytology inadequate 2nd letter
- Cytology inadequate 3rd letter

When you finally come to merge the template letter with a group of patients in Patient Groups, or from Recalls or Referrals in Consultation Manager, you have the
opportunity to view and edit the letter just before the letters are printed, when you can amend text or add and remove merge fields.

First choose which Word Processor

From the Vision Start-up menu, select Options – Setup – then click on the Word Processor tab. You can choose between Vision Editor or Microsoft Word 6.0 / Word 2000 as the default word processor.

Whichever is chosen is then used when adding a template letter to merge with patient details from Referrals, or from Correspondence on the Add Data menu, Consultation Manager; or in Patient Groups, under Generate Recalls - Create Personalised Letters.

Note that if you select Microsoft Word 6.0, you may also select Save as rtf. This will allow you to have a mix of Word versions – Word 6, Word 95, Word 97, Word 2000 - to save files in a commonly viewable format.

Choice of word processor for clinical correspondence, Options, Start-Up Menu

Note - In Control Panel - File Maintenance, under Staff

Staff, it is possible to select Actions - Staff Configuration and specify a word processor choice by workstation. We recommend that to avoid confusion, the same word processor choice is made throughout the practice.
Set up recall templates in Word or Vision Editor

Select **Word Processor**, from the **Modules** menu (Alt-M, W) or from Utilities on the Vision Front menu. This displays the Select Template Type screen.

1. Select **Recall** and click **OK**. The choice determines which merge fields are available for inclusion in the letter. Once you have chosen, say, Referral, you cannot then include Recall merge fields. To start another letter, save and close the first, and re-enter selecting the required template type.

   - **Practice** - for a template including only practice name and address merge fields for the letter heading (and no patient or recall merge fields).
- **Patient** - for a template including practice and patient merge fields, but no recall merge fields.
- **Recall** - for a template including practice, patient, and recall merge fields of Recall Date, Recall Reason and Recall Clinician.
- **Referral** - for a template including practice, patient and referral merge fields including the hospital department and consultant, Read term, date and so on (Referral letters are explained in Chapter 23).

2. A document is opened. In Word this is called *Document1* until you save it with a different filename. In Vision Editor, it is called VizDoc1 until saved. Click on **File, Save As**, or .

   - Type in a filename and extension. Word documents have an extension of *doc*, for example, *smear1.doc* for smear recalls. Vision Editor templates have an extension of *txw*.
   - Select a directory. The convention is to save all template letters vision\data\wordproc\template.
   - Click **OK**.
   - Remember to save the template at intervals while you are creating it, and especially when you have finished before exiting.
Initial Word screen

Initial Vision Editor screen before maximising

Vision Editor screen (blank) after maximising
Some hints:

- **Merge fields** can be placed within the letter using the **Insert Merge Field** button (see below for more help with this).

- **Fonts** are varied using Format – Fonts in Word, or Format – Character in Vision Editor.

- Positioning of lines can be varied. For instance, if you want to place lines such as the practice address on the right, highlight and select Format – Paragraph – Alignment – Right, or click on ≠. To align to the left, click on ≈. For central alignment, click on ≈.

- Remember to place a single space between merge fields, such as Patient Surname (space) Forename

- If you want to set up another template for either recalls or referrals, but with different wording: select the relevant template as in step 2 above, and at the blank new document screen, open the original template (eg, File- Open – referral doc/txw), block highlight the top section of the existing template with the practice heading, system date, patient’s merge fields, the salutation (Dear...), and do Control-C to copy it to Windows clipboard. Using Windows, switch back to your new document and Click Control-V to paste this in. You can then go on and type in the text of the letter.

- **Save** as you go!
The merge fields available for recall letters

1. The practice name and address: (If you are using headed notepaper, you will not want to include this step). To include the practice name and address:

   - Click on Insert Merge Field. Select the PRACTICE_Name. You can centre it if you like – with the cursor on that line, either ☐ or Format – Paragraph – Alignment – Centre.

   - Click Enter for a new line to enter the practice address. To align it to the right margin, either click on ☐ or Format – Paragraph – Alignment – Right.

   - Click on Insert Merge Field and select the Practice House, Click the space bar, click on Insert Merge Field, and select the Practice Road. Click Enter.

   - Continue entering the practice address and phone numbers. Then Click Enter a few times.
• These fields are all picked up from File Maintenance - Practice Details.

2. **The date of the letter** - Insert Merge Field - SYSTEM_Date. This will insert under the address on the right. Click Enter two or three times.

3. If you are typing a recall letter, the patient’s name and address is next. Click on the left justify button before you enter the patients’ merge fields for name and address.
   - Click on Insert Merge Field. Select Patient Title, press the space bar.
   - Click on Insert Merge Field. Select Patient Forename1, press the space bar.
   - Click on Insert Merge Field. Select Patient Surname. Press Enter for a new line.
   - In turn, click on Insert Merge Field and enter the patient’s address in merge fields. Do not forget a postcode line.

4. **The Salutation** - Press Enter to clear a couple of lines, then type the word Dear.
   - Click on Insert Merge Field.
   - Select in turn the patient title, space, patient surname.
   - Press Enter two or three times.

5. **The text of your letter.** Now type the text of your letter. You can include any merge fields that are available.

6. End the letter with Yours sincerely, press Enter a few times then Insert Merge Fields – RECALL_Clinician.

7. Click on Save and in the vision\data\wordproc\template directory, save Word templates with an extension of .doc, or Vision Editor templates with an extension of .txw.

8. Close the document with File – Close then File - Exit. You may see a message which says: *(Filename) is a mail merge main document that is attached to a data source WORDEDIT.TXT that has not been saved. Do you want to save WORDEDIT.TXT? Yes / No.* Answer Yes to this.
You should now have the Vision Front menu on screen.

Now repeat the whole process to create the other recall letters:

1. CXLET2 - 2nd invitation letter
2. CXLET3 - 3rd invitation letter
3. CXINADLET1 - 1st invitation letter to repeat an inadequate smear
4. CXINADLET2 - 2nd invitation letter to repeat an inadequate smear
5. CXINADLET3 - 3rd invitation letter to repeat an inadequate smear
Index

A
Add a New Cervical Smear (Smear Taken) • 6
After 3 Cytology invites enter – Ca cervix screen – not wanted • 38
After 3 invites for inadequate result enter Ca cervix screen – not wanted • 45

B
Batching the searches • 24
Building the Cytology Searches • 15

C
Cervical Cytology - groups from Clinical Audit • 54
Cervical Cytology Recall Search • 49
Codes to trigger recalls • 11
Combine or exclude patients within groups • 56
Copyright Notice • ii

E
Emails and Vision for flu clinics • 68
Exclude a patient, eg with hysterectomy, from cervical cytology target figures • 11

F
Filtering out Clinical Audits from Patient groups • 25
Find patients with specific smear results such as severe dysplasia • 52
Finding Cytology results with NO cytology recall in last 5y • 13, 15
Finding Hysterectomies in a Medical History • 16
First choose which Word Processor • 70
First record that the smear has been taken • 6

G
Generate recall letters • 14

H
How do I create template letters for recall? • 29, 69
How to add a Recall • 5
How to run the Cervical Cytology Recall • 13

I
Introduction • 5

P
Print labels for the recall letters • 31, 37, 38, 57
Print out a list of patients sent a letter • 67
Printing Patient Address Labels in Microsoft Word • 58

Q
Quick recap • 14, 25

R
Recalling patients with inadequate smears • 42
Review the group • 55
Review the Groups in Patient Groups • 49, 55
Run the Cytology Recall Search • 18, 49
Running the Monthly Cervical Cytology Recall Search Procedure • 24

S
Search 1 - Automatically exclude those who have just had a cytology performed and are awaiting the result • 17
Search 2 - Search for the last cytology recall (Set up Date) in a patient’s record looking back 5 years and forward 1 month, excluding hysterectomies • 18
Search 3 - Find patients who are pregnant, have a referral for colposcopy, and last smear test was either inadequate or not sexually active • 19
Search 4 - Find patients who have no cytology entry ever - they also need a 1st invite letter • 20
Search 5 - Last Cytology result • 21
Search 6 - Last Cytology result • 22
Search 7 - Last Cytology result • 22
Search 8 - Last Cytology result • 23
Select the Right Read Codes For Smear Result • 8, 10, 53
Sending out 1st Cytology Letter • 26
Sending out 1st recall for Inadequate Cytology • 31, 42
Sending out 2nd & 3rd recalls for Inadequate Cytology • 45
Sending out 2nd Cytology Letter • 32
Sending out 3rd Cytology Letter • 37
Set up recall templates in Word or Vision Editor • 71
Smears and Recall • 5
Some points about the Cytology Recall Search • 18, 49
The monthly searches • 14
The steps • 13

Update an Existing Smear Result when result arrives • 7

What you are trying to achieve • 13